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THE CHASE IS ON...

Maonday, 5 a.m. A ringing sound jars you awake. You grope
for the phone and drop the receiver on the floor. Cut of the
darkness comes the voice of the chief: “Wake up, kid. Gotan
assignment for you.”

You stumkle out of bed, turn on the light and grab your brand
new detective’s notebook.

“Just got a call from Interpol,” says the chief. “Looks like
Carmen's gang has pulled ancther caper.”

“Any leads?” you ask.

"Not with this bunch. They're too slick. Can't give you any more
details on the phone. Better get down to the office double
quick. It's going to be a rough one”

“Right, chief.”

As your irembling hand replaces the phone on ifs cradle, you
wonder why you ever got into this line of work. Before this
morning, Carmen Sandiego and her Villains' International
League of Evil (or V.I.L.E.) were jusi sensational headlines In
the newspaper. For more than five years, Carmen and her gang
of felons had managed io stockpile the world's most valuable
treasures, while outwitting every so-called “crime expert” from
New York to Sydney. Now they’ve struck again. And you, the
newest employee of the Acme Detective Agency, have been
given the near-impossible assignment of tracking them down.

Good luck!




GETTING STARTED

Loading the Program

Macintosh:

Turn on your computer. Insert the WHERE IN THE WORLD 15 CARMEN
SANDIEGO? program disk into your disk drive. Double-click on the icon
titled Carmen World when it appears on the deskiop. The program will
load itself into your computer and on animated title sequence will appear.
Click the mouse button to stop the animation and begin the game.

Apple lies:

For two disk drives:

Insert both disks of WHERE IN THE WORLD IS CARMEN SANDIEGO? into
their respective disk drives. Turn on your computer. Double-click on the
Carmen World icon when it appears on the screen. The program will load
itself into your computer and an animated title sequence will appear.

Click the mouse button to stop the animation and begin the game.

For ane disk drive:

Insert Disk 1 of WHERE IN THE WORLD S CARMEN SANDRIEGO? into your
disk drive. Turn on your computer. When the disk icon appears on the
deskiop, eject Disk 1 by pressing the button on the disk drive. Insert Disk 2.
Double-click the Carmen World icon when it appears on the screen. At this
time you will be prompied to swap disks; follow the instructions on the
screen. After the program has loaded itself into the computer, an animated
title sequence will appear. Click the mouse butten to stop the animation
and begin the game.

Mote: The program requires ROM version 1.0 or higher.

Amige:

Turn on your computer. Insert the WHERE IN THE WORLD 1S CARMEN
SANDIEGO? program disk into the disk drive. (Amiga 1000 users will have
to insert the Wickstart™ disk first.) Double-click on the disk icon, then on
the Carmen World icon when it appears on the Workbench.™ The pro-
gram will load itself into your computer and an animated title sequence will
appear. Click the left mouse bution to stop the animation and begin

the game.

Installing the Program on a Hard Disk:

Apple lies:

Copy all files (excluding the system folder) from the Carmen Program
Disk(s) to a folder on the hard disk. For more information regarding copy
procedures please refer to vour computer manual.

Apple lles Mote: The 512K Apple lics computer with a hard disk drive
requires "Carmen World” to run with a 3.2 system disk {system disk
is included with the program).

If you are using System 4.0 or later on your Apple lics system, you will need
to have more than 512K RAM installed.

If you are using System 5.0 or later on your Apple liGs system, copy Tool 032
from your Apple System.Tools disk into the Tools folder in the System folder
on your startup disk before running Carmen.



Bmigo:

Turn on your computer and hard disk. Double-click the icon for
your hard disk to open the hard disk window. Create a new
drawer by single-clicking the Empty drawer icon on your hard
dick and then choosing Buplicate from the Warkbench menu,
Rename the new drawer, which will now be named Copy of
Empty, by single-clicking it and selecting Rename from the
Werkbench menu. Rename the drawer Carmen Werld, Insert
the Carmen Werld disk inte your floppy disk drive.
Double-click the Carmen Waorld icon. Drag the drawer icon
named Cermen World Data and the program icon named
Carmen Werld from the floppy disk o the new drawer on your
hard drive. Double-click the Font Mever icon. Click the gadget
that represents the destination to where the Font Mover
should copy all of the fonts on the Carmen World program
disk. You should select the font directory on your hard drive or
the font directory on the Workbench floppy disk that you
usually start up your Amiga with.

Hold down the left mouse button and drag the curser over the
fonts that you want to copy to the destination directory. You
should select all of the fonts on the Carmen Warld program
disk. The fonts highlighted will be copied to the destination
directary.

Click the Copy gadget fo initiate the copy procedure. After the
Fant Mover has finished the copy, click the Close gadget in the
upper left hand corner of the Font Mover window.

USING EXPANDED MEMORY

Amigas

If you have one megabyte or more of memory you can run
WHERE IN THE WORLD IS CARMEN SANDIEGO? faster by telling
the program to use more memory. The program will use about
512K of additional memory. To run the program using additional
mermory you will need to change the Nto a Y in the tool types
of the Carmen World program icon.

Single-click the Carmen World program icon. The icon should
now be highlighted,

Go to the menu bar and place the pointer over the word
Workbench. Press the right mouse button and select Infe frem
the pull down menu.

The info window will appear with Carmen Warld in the Name
box. Toward the bottom of the Info window, a box will say:
TOOL TYPES BIGMEM=N
Change the N te a Y for Yes.
Click the Save gadget at the bottom of the Info
window. The change will be saved, and the
info window will close.




The program will now run with additional data in memeory.
Should there be too little memory for the program to run with
BIGMEM=Y, an alert will appear when you iry torun the

rogram. If you see the message, “Not enough memory ! go
Euca into the Info window and set BIGMEM =N.

ONE LAST NOTE!

Carmen World is designed to run from your Workbench.
There are two keyboard commands that you might find
valuable. The “A” shown below refers to to the Amiga key to
the left of the space bar. By holding down the Amiga key and
pressing the “n” or "m” youw will achieve the following results:

A4n: bring the Weorkbench forward
A-+m: send the Workbench to the back

Using the Program

Macintosh and Apple les:

Except for entering your name into the Acme Crime Computer,
your keyboard need not be used at all when playing WHERE IN
THE WORLD 1S CARMEN SANDIEGO? However, if you enjo
using the keyboard, you may prass the Return key instead of
clicking the mouse whenever you see the prompt, “Please click
here to continue.” In addition, you may type in ¥ for Yes and M
for No instead of clicking the mouse on the appropriate button.
You may also simply press the Return key to signify a "Yes"
response.

Amigea:

Whenever you see the prompt, "Please click here to continue”
you must click the left mouse buiton or hit Return. The menu
bar is hidden while ploying the game. In order to see the menu
opfions and make o selection, click the right mouse button.

TO CATCH A THIEF
Signing-in

The investigation begins at the Acme Detective Agency, your
home base. Typs your name into the Crime Computer and then
press Return. Once you've signed in, the Acme Crime
Computer will display your current rank os a detective and give

f Detective at
eypoord, please
idant |y youwself

Maeiniash



you the details of your assignment. These include what
treasure has been stolen, where it was stolen from, whether
the thief is a male or female, and your deadline for arresting
the criminal, When you're ready to continue, simply click the
mouse or press Return and you're on your way.

Resuming a Saved Game

If a game has been previously saved under the name you type
into the Crime Computer, you will be asked if you want fo
resume that game. If you do, the Crime Computer will refresh
your memory on the state of the game as you left it. If you don’t
resume the saved game, it will be lost when a new game is
begun under the sume name. For information on how 1o save a
game see the File menu, page 10 under “The Menus™. To speed
the scrolling text, simply press the 38 key.

Nete: To speed the scrolling text, simply press
the F1 key.

YOUR ASSIGNMENT

The thief is hiding out in one of 30 cities. Your job is to track him
or her down, using clues you unearth along the way. Clues can
lead to the city itself or the country in which the city is located,

Clues to the identity of the thief will be given fo you as you
pursue the villain from city 1o city. You'll log these clues into the
Crime Computer. When the identity of the suspect has been
established, the Compuier will issue an arrest warrant.
Obtalning @ warrant is very important. If you don't have
one, you won't be able fo arrest the thief once you catch
vp with him er her.
There are 10 possible suspects, any one of whom could be the
thief. Carmen Sandiego is the mosi elusive of the lot. During
your search, the Police Dossiers menu allows you to select the
individual crime file for any of the suspecis. The crime files are
?Iso available at the end of this manual in a slighily different
orm.

As a new detective, you begin at the Rookie level. As your
investigative skills improve, you climb your way up through the
ranks—five levels in all—until you reach Ace Detective. The
higher your rank, the tougher the case you'll be assigned.

The Crime Computer, THE WORLD ALMANAC® AND BOOK OF
FACTS and the Police Dossiers will all be useful in unraveling
clues.

Work quickly. You have only a limited amount of time to sclve
the case. The Crime Computer will let you know what your
deadline is.




Before being promoted to each new level, you must pass
o Qualification Quiz using THE WORLD ALMANAC
included in the package. You will have three chances to
answer correcily. If you poss, you will be immediately
promoted. If you tail, you will need 1o solve another case
before you can retake the quiz.

BEGINNING THE SEARCH

Your starting point is the scene of the crime—the city where
the thief swiped the trecsure. You should refer 1o your Official
interpol Map (in this manual, poges 12 and 13 to orient your-
self geographically ofter arriving at this city or any of your
subsequent destinations,

The main screen always gives your present location and tells
you what time it is and what day of the week it is. As you arrive
in each new city, be sure to read the descriptions that appear
on the screen. The descriptions contain infarmation that will be
useful in pursuing Carmen and her gang. The pictures

themselves—notable landmarks or typical scenes from that - E@@@

country—may alse come in handy.

TOOLS OF THE TRADE

Apple llas

The icons in the lower right of the main screens provide the
means to locate and arrest your suspect.

The menus across the top of the screen provide useful informa-
tion about both gang members and crimefighiers.

The lcons

_ Clicking this icon will show a list of all the possible
o destinations reached by connecting flights from your
& j
present location.

1t's a good idea fo do this first to see where the thief
;‘5‘5’ might have gone. Clicking the mouse on the icon a
&1 second fime will hide the list from the screen.

Buenos Alres
Kathmanduy

Paris
Fig de Janeiro

Applellos




Mote: If you double-click on one of the listed destina-
tions you will immediately travel to that lecation. This
provides a shorteut alternative to clicking on the
Depart icon described below.

Clicking this icon lets you unearih clues within

4® each cily so you can track the suspect fo the nexi
destination. A window will be displayed containing
three specific locations for you to investigate. Simply click
the one you desire.

Marketplace

Bl

Palace

Cancel

Appla lles

Visit as many or as few locations as you wish, but remember
that the more investigating you do, the more valuable time you
lose. Use THE WORLD ALMANAC to help unravel the clues

you dig up.

—— Clicking on this icon lets you depart for the city of your
3. fchoice once you're ready to take off affer the suspect. A
{ e map will be displayed on the screen with a blinking dot
at your current location. Simply click on the city to which you
want fo travel.

Apple dlos




— When you think you've gathered enough clues to

EEE | identify the criminal, click this icon and the Interpol
== Crime Computer will be displayed. The Crime Computer
lists various identitying characteristics on its screen, Click each
characteristic repeatedly to cycle through the available
choices.

Amiga

When the characteristics you want are displayed, click on
Compute and the Crime Computer will search through all
known facts about each possible suspect. A warrant will be
issued if the characteristics you entered into the Crime Com-
puter fit the profile of only one suspect. If the characteristics it
more than one suspect, the names of all possible suspects will
be displayed. In this case you'll have to gather more clues
befere a warrant will be issued. To return fo the search, click
any icon below the Crime Computer.

The Menus

The Police Dossiers menu contains a crime file on each of the
members of the Carmen Sandiego gang. Each file contains the
identifying characteristics of a particular criminal.

(& 1
2 Carmen Sandiego...
Merey LaRot...
Dazzie Hnnie Nonker ...
Lady Rgatha Wayland...
Len *Red” Bulk...

scar Graynolt...

P hﬁ‘di‘ém“xs'-

Mame: Caren Sandiego

Sn Feinale

Drupriion: 7 armar re vor ihe
INiETRgense SOreice £1 Hemdin
Hebibay: Tenfiis

i €odor: Feddion-Dromm
Rein: 1879 Pockacd conesliale

s

Nick Brunch... i E
< L FeeATUTED Meswer spDEOTS VDGR v ILROUL Pt LDy

Fast Eddie B.... | e i

ihor therowiich... 1 mtmer: Beeat fondness tor tacnn. y

Katherine ‘Boom-Boom” Orib... 3 i

{ AT - e TNy T T

maclntosh




The Game menu contains the Hall of Fame which lists all the
crimefighters that have managed to capture Carmen Sandiego
herself. The menu also contains the Acme Detective Roster
which provides a list of all crimefighters and their current rank.

f ® Flla o Police Dossiers
Hall of Fame... #H
Acme Detective Boster...  ®0

The File menu allows you fo begin a new game by selecting
New Game. Your old game will be lost when you do this. Se-
lecting Quit from the File menu lets you leave the program.
After selecting Quit the current game, if a game is in progress,
will automatically be saved.

Game Folice Dossiers

?'ﬁe‘iu‘]

#0 |

The Edit menu is not used af all in the Maciniosh and Apple ligs
versions of WHERE IN THE WORLD IS CARMEN SANDIEGD.
it is provided only so that you can use it with Desk Accessories.

USING THE WORLD ALMANAC

Your most important investigative tool is THE WORLD
ALMANAC . Here you'll find information about nations of the
world plus other focts you'll need to catch your suspect. Start at
the index, located in the front (not the back) of the book to find
the country or other subject in question. Remember: Clues may
point io either the connecting cities or other locations within
those countries.

Examples for Using THE WORLD ALMANAC

What country uses kroner as its currency?

1. Check your connections to find ocut which cities the thief
might have fled to. The possible connections could be Mon:
treal, Londen, and Oslo.

2. Check your QFFICIAL INTERPOL MAP to identity the countries
where each city is located. You'll find Mentreal in Canada,
London in the United Kingdom and Osle in Norway.

3. Locate these countries in the index ond turn to the appropri-
afe pages.




4. By looking under “Finance: Currency” in the section describ-
ing each country, you'll discover that the kroner is used in Nor-
way, the dollar in Canoda, and the pound in the United
Kingdom. Looks like Norway is where you should head!

Where does the king cobra live?

1. Again, first check your connections, then use your OFFICIAL
INTERPOL MAP to identity the countries where these cities are
located.

2. Think of the general category in THE WORLD ALMANAC
where you might find information about king cobras — in this
case, snakes.

3. Lock up “Snckes” in the index, and turn to the appropriate
page.

4, Find "King Cobra” under "Snakes.” From the description, you
now know that its home is South Asia. If one of the connecting

cities were Bangkok, the capital of the Southeast Asian nation
of Thailand, this city would be a good place to go!

SLEUTHFUL HINTS

The thief cleverly stays in hiding, and orders a crony to check
you out. When you see ¢ suspicious persen run across the
screen, you know you're on the right track,

No thief worth his or her salt gives up without a fight. The
closer you get, the more dongerous your situation becomes.

Use the Crime Computer sparingly or you'll use up valuable
hours. And don't waste time playing tourist or aimlessly criss-
crossing the globe. Instead, use THE WORLD ALMANAC to
decipher clues and keep your investigation time down.

Be sure you've been issued an arrest warrant by the Crime
Computer before you cateh up with the thiel. If you don't have a
warrant, issued for the correct suspect, you can’t make an
arrest and the thief will slip through your fingers.

Every case is different. Whenever you begin a new assignment,
you start at a new city. You'll be locking for a new stolen trea-
sure, and a new suspect.

If you've reached the top of the detective ranks and have been
retired, you can get back on the job by picking an assumed
name. Your real name could be on a hit list!




CURRENTLY KNOWN V.I.L.E. OPERATIONAL BASES

hge et ®

Mexleo Ciy
(MEXICO)

Lil

(PE

(PAPULA MEW GUINES)



Reykjavik

(ICELAMD)

Y Rio de Janeiro
[BRATIL)

enos Aires
[ARBENTINA)




POLICE DOSSIERS

The following information has been gleaned from
interpol's files and our field agents. While
brief, these descriptions may contain
valuable clues to be used in tracking down
and identifying members of the V.I.L.E.
organization,
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We encouraga you to moke a backup copy of each disk. Store the
ariginal disks in a safe place and use the duplicates to play
the gome.

Please da net make illagel copies of this program

The software you are using was produced through the efforts of
many people: designers, artists, programmers, distributors, retail-
ers and other dedicated workers. The costs of developing this and
other software programs are recovered ihrough software sales. The
unauthorized duplication of personal compuier sofiware raises the
cost to all legitimate users.

This seftware is protected by federal copyright law. Copying soft-
ware for any reason other than to make a backup is a violation of
law. Individuals who make unautherized copies of softwara may be
subject to civil and criminal penalties.

Brgderbund Software, Inc.

as a member of the Software Publisher's Association (SPA), supports
the industry’s effart to fight the illegal copying of personal computer
software.

Report copyright violation fo:

SPA

1101 Cennecticut Avenue NW
Suite 901

Washington, D.C. 20036



Warranty

Brederbund’s Limited Ninety-Day Warranty

Bradarbund warronls for o period of ninsty (90] days follewing the origingl retal purchass of His
copy of Where in the World is Carmen Sandiege? that the program i free from substantial
errars or defects that will materially inferfere with the aperation of the program as descrilbed in the
enclosed user dacumentation. This pelicy applies to the inial purcheser anly.

IFyou beliova you hove found any such errer or defect in the program during the warranty peried, call
Bredarbund’s Technical Support Depariment af 41.5/382-4700 betweern the heurs of 8 am. and 5
pm. (Pacific Time), Mend ey through Friday. Brederbund techieal parsonnel will attemnpt to help you
carradt or avoid the prablem. I any such error or delect cannet be corredted o reusonably avaided,
Braderbund will inform you how to chiain o corrected program disk (or, et Broderbund's ophion,
Braderbund moy autherize a refund of your purchese pricel.

This werreinty gives you specific legal rights, aind you may slso have rights which vary fram siate to
stole,

Disk Replacamant Policy

IFany disk supplied with this product fails within ninety (90} days of purchase for any reason other
than nzcident or misuse, pleass return the deledtive disk together with a dated prest of purchase ta
Braderbund Software-Dirsc®, PO, Box 6125, Mavato, CA 94048-61 25, for a frea replacamant
This policy applios fo the original purchaser only.

Braderbund will replace program disks domaged for any resson, whether during ar after tha ninety
{20) day frea replacement pariod, for 85 per disk plus @ postage and handling charge of £2.50 per
request. For programs that originally include 3 or mors program disks, sand just $15.00 and $2.50
pestage and handling per request. This policy will be followad as long 0s the program s stil baing
marufactured by Brederbund.

Limitations on Warraniy

Unautharized representations: Brodarbund warrants snly theit the pragram will perform os described
in the user documantation. Na ather aclverlising, descriplion or rapresantation, whether made by a
Braderbund dealer, distributer, agent or employee, shall be binding upan Braderbund or shall cha nge
thet terms of this warranty,

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, BREDERELMND MAKES MO OTHER
WARRANTY, EXPRESS OR IMPLED, REGARDING THIS PRODUCT. BREDEREUMND DISCLAIMS AMNY
WARRANTY THAT THE SOFTWARE |5 FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLED
WARRANTY OF MERCHANTARILITY SHALL BE LIMITED TC THE NIMETY (90) DAY DURATION OF
THIS LIMITED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFICALLY
DISCLAIMED. SOME STATES DO MOT ALLOW LIMITATICHNS ORN HOW LOMNES AN IMPLED
WARRANTY LASTS, SO THE ABOVE LIMITATICN MAY NOT APPLY TO YOU,

MG CONSEQUENTIAL DAMAGES: BREDERBUND SHALL MO BE LLABLE FOR SPECIAL,
INCIDEMTAL, COMSEQUENTIAL OR CTHER DAMAGES, FVEN IF BREDERIUNGD 15 ADVISED OF OR
AWARE OF THE POSSIBILTY OF SUCH DAMAGES. THIS MEAMS THAT BROIDERBUND SHALL NOT
BE RESPOMSIBLE CR LIABLE FOR LOST PROFITS OR REVEMUES, OR FOR DAMAGES OR COSTS
INCURRED A5 A RESLILT OF LOSS OF TIME, DATA OR USE 0OF THE SOFTWARE, OR FROM ARNY
OTHER CAUSE EXCEPT THE ACTUAL COST OF THE PRODUCT, [N MO EVENT SHALL
ERGDERBUND'S LIABILITY EXCEED THE FURCHASE FRICE OF THIS PRODUCT, SOME STATES DO
MOT ALOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES.
S0 THE ABOVE UMITATION OR EXCLUSION MY MOT AFFLY TG YOLUL

You are entifled o use this preduct for your own use, bul may not sell or ranster repraductians of the
soffware or maruel fo cther perfies in any way, nor rant or lease the praduct to athers without the
priar writfen permission of Braderbund. You moy use ene copy of the product on o single fmminal
connscted to o single computer. You may nof netwerk the procuct or etherwise use it on mors than
ore compuler or compuler terminal et the same fime.

For technical suppert, on this or any olher Braderbund praduct, eall 415/382-4700.

© Copyright 1985, 1921 Brederbund Software, Inc., All rights reserved.
500 Redwaod Blvd., Novate, CA 94948-6121. R101
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WHE RE ON EARTH WILL
SHOW UP NEXT?

Congratulations on joining the
Acme Detective Agency!

You're about to discover how
much fun it is to track down Carmen
Sandiego and her gang of master
thieves!

And when vou've mastered “Where
in the World . . . there's still more
adventure waiting for you: Three other
great Carmen Sandiego games are
available.

WHERE IN TIME 15 CARMEN
SANDIEGO?™

Chase Carmen through the ages!
Investigate 1500 years of historical
events, famous people and important
inventions. Includes the New American
Library® Desk Encyclopedia.

WHERE IN THE USA IS CARMEN
SANDIEGO?®

The whole USA is your beat! Carmen
and her gang are stealing America’s
national treasures, and you're on their
trail. Includes Fodor's® USA Travel Guide
to help vou decipher clues.

WHERE IN EUROPE IS CARMEN
SANDIEGO?®

Carmen strikes again! This time you'll
pursue Carmen through the 34 nations
of Europe. For vital information, you'll
have an on-screen data-base and the
Rand McNally® Concise Atlas of Euvope.

Carmen Sandiego Cgroducts are availablg for the IBME
PC/Tandy®, Apple® II, Apple® IlGS, Macintosh®,
Amiga® and Commodore 64/128. (All tites may not
be available for all computers.}

Visit your local software dealer or call (800) 521-6263, 8am-5pm PT
for credit card purchases and ordering by mail.

Bmdqe@rﬁbund@

For more information, write (o Braderbund Software-Divect, P.0. Box 6125, Novato, CA 84848-6125, © Copyright 1890 Brederbund
Soltware, Inc., 500 Redwood Blvd., Novato, CA 04948-6121, All rights reserved. The New American Desk Encyclopedia, Fodor's and
Rand MeNally are registered trademarks of New American Library, Fodor's Travel Publications, and Rand McNally and Company,
respectively. [BM, Tandy, Apple, Macintesh, Amiga and Commodore are registered trademarks of International Business Machines

Corp., Tandy Corp., Apple Computer, Ine. and Commaodore-Amiga, Tne., respectively,
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